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1 Introduction ToF Tool
1 Introduction

1.1 Installation

Before you install ToF Tool, you must fulfill a number of requirements. For more details, refer to the 
Installation Instructions which is located on CD-ROM 1.

1.2 Scope of delivery

The scope of delivery cinsist of 2 ToF Tool - FieledTool Package CD-ROMs.
• CD 1: ToF Tool - FieldTool Program

Program including Device Descriptions (device drivers) for all Endress+Hauser devices wich can 
be operated by ToF Tool.

• CD 2: Documentation Pack (= device documentations).

1.3 Typographical conventions in this manual

To make the contents of this manual more understandable and highlight important items, we have 
used the following typographical conventions.

Visual cues
Below is a short list of the visual cues used in this manual.

Symbols
The manual uses the following graphic symbols:

Visual cue Function Example

"bold in 
inverted commas"

Keys, buttons, program icons, tabs, menus, 
commands.

"Start -> Programs -> ToF" or 
"Enter"

Choose "Print" in menu "File".

Hold down CTRL (CONTROL) and press 
SHIFT.

Hold down CTRL and press SHIFT.

Hold down CTRL and click the left mouse 
button.

Hold down CTRL and click the left 
mouse button.

Capitals Paths and filenames in continuous text. DOKU\FMR2XX.PDF or WIN.HLP

Angle brackets Variables <CD-ROM-drive>

Symbols Meaning

# Caution!
A warning highlights actions or procedures which, if not performed correctly, will lead to 
personal injury, a safety hazard or destruction of the device.

" Note!
Caution highlights actions or procedures which, if not performed correctly, may lead to 
personal injury or incorrect functioning of the device.
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ToF Tool 2 Starting the Program
2 Starting the Program

2.1 Starting the program under Windows 2000/NT or XP

How to start the program:

1. Click the Windows button: "Start -> Programs -> Endress+Hauser -> ToF Tool - 
FieldTool Package -> Start ToF Tool - Fieldtool Package" to start the program.

Note!
As an experienced user, you have the option of just starting the ToF Tool or Fieldtool directly and
scanning through all or individual buses.
• You can start the ToF Tool directly via:
"Start -> Programs -> Endress+Hauser -> ToF Tool - Fieldtool Package -> Configure
level and pressure devices (ToF Tool)".
• You can start the Fieldtool directly via:
"Start -> Programs -> Endress+Hauser -> ToF Tool - Fieldtool Package -> Configure
flow devices (Fieldtool)".
You also have the possibility of opening the appropriate device documentation directly in Acrobat
Reader via:
"Start -> Programs -> Endress+Hauser -> ToF Tool - Fieldtool Package -> Documentation
Pack -> ...".

2. The window for the Connection Wizard appears:
– Here you can scan through all or individual buses (HART, PROFIBUS DP, Service, etc.) and 

look for connected devices.
– You can save the result as a ToolShell file with the extension "*.tsh" in the EHToolShell 

directory and open it as required.
– A number of demo devices are also installed for off-line demonstration.

3. Select a device from the live list. The connection is established by clicking the "Connect" 
button or by double-clicking in the live list:
– The ToF Tool is automatically started if you selected a level or pressure measuring 

instrument.
– The FieldTool is automatically started if you selected a flow measuring instrument.

4. In the Connection Wizard, you also have the opportunity to alter bus settings afterwards.
Endress+Hauser 5



2 Starting the Program ToF Tool
5. Here you can configure a modem.

6. Here you can configure the individual buses (HART, PROFIBUS, Service, etc.).
6 Endress+Hauser



ToF Tool 2 Starting the Program
2.2 Closing the program

" Caution!
Remember that before an Exit you should save the Device List and Envelope Curve, unless you are 
sure you no longer require these data.

How to close the ToF Tool program:

1. Click "Exit" in the "File" menu.
2. The window for the Connection Wizard appears.
3. Click "Exit".
Endress+Hauser 7



3 User interface ToF Tool
3 User interface

If you set up the connection to a device or open an existing Device List, the ToF Tool screen will 
look like this:

Fig. 1: ToF Tool main screen

The ToF Tool main screen contains the following elements:

• Title Bar
• Toolbar
• Parametrisation Editor (see Page 10)

– Navigation Window (see Page 11)
– Error List (see Page 13)
– Header (see Page 44)

• Device List (see Page 16)
• Status Bar (see Page 19)
• Menu bar (you find a detailed description of the menus on Page 20-92)
• and a separate Help window (see Page 93).

Status Bar

Title Bar Menu Bar
Toolbar

Parametrisation Editor

HeaderErro ListNavigation Window

Device List
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ToF Tool 3 User interface
4 Title Bar

The title bar contains the following information:
• Device type
• Version
• Measuring point TAG

5 Toolbar

The toolbar contains separate icons or icon groups e.g. toolbars for editing envelope curves.

Standard toolbar - Open, Save, Print, etc.

Buttons to toggle Device List, Configuration Menu and QH-curve

Buttons for Scan, Show parameters, Connect, Disconnect

Toolbar for Envelope Curves

Buttons for linearisation table: export, import, display
Endress+Hauser 9



6 Parametrisation Editor ToF Tool
6 Parametrisation Editor

Fig. 2: Parametrisation Editor

How to open the Parametrisation Editor:

1. Double-click the mouse on an entry in the Device List or TAG view.
2. Click the mouse on an entry in the Device List or TAG view and select "Edit Parameter" in 

the menu which opens.
3. Click the mouse on the button in the toolbar.
4. Open the "Devices" menu and click "Edit Parameter"

The Parametrisation Editor consists of two views:
• the Navigation Window and
• the Parameters dialog window or
• the Envelope Curve dialog window or
• the Linearisation Table dialog window or
• the HistoROM dialog window.
10 Endress+Hauser



ToF Tool 6 Parametrisation Editor
6.1 Navigation Window

On the left-hand side of the Parametrisation Editor, you can find the Navigation window with a list 
of the device parameters in a directory tree structure.

Fig. 3: Navigation window

How to activate and deactivate the Navigation:

1. By means of the “View” menu
2. By means of the Navigation window button in the tool bar.

The Navigation window is automatically generated from the device description and thus depends 
on the device and the device description. This is split into groups in a directory structure. Expanding 
and closing the directory structure makes information management and the configuration easier.

How to open a parameterisation screen:

1. By using the mouse to click an “Entry” in the Navigation window.
The parameterisation screen is displayed in the dialog box. Under the entry opened,
the Navigation window displays the parameters belonging to the parameterisation group.
The parameters are also displayed in the open parameterisation screen.

2. By using the mouse to click a “Parameter” in the Navigation window.
In the on-line mode, the value in brackets beside the parameter name displays the current 
value from the device.

Button for the Navigation window
Endress+Hauser 11



6 Parametrisation Editor ToF Tool
6.2 Parameter window

The  parameterisation screens are displayed in the Parameter dialog window. The parametrisation 
screens displayed are automatically generated by the device description or when the 
Parameterisation Editor opens or when the page changes. Like the Navigation Bar, they are 
dependent on the device and the device description.

Fig. 4: Parameters window

The Parameters window consists of:
• Headline,
• Input Window,
• Footer.
12 Endress+Hauser



ToF Tool 6 Parametrisation Editor
6.2.1 Header

Fig. 5: Header in the Parameter window

The headline contains:
• The device name
• The device type
• Prominent parameters (see Chapter 9.6.3)
• Header area

The parameter view (e.g. current measured value, output current, measured distance etc.) can be 
individually configured for every device type here (see Chapter 9.6.3).

• Error list
The “Status” window always shows the latest error message.

How to navigate through the error list:
• Click the UP or DOWN button to display an error message in the “Status” window.

• Click the  button to display the latest error message in the “Status” window.

• Click the  button to delete the error messages.

Prominent Parameter
Error List

Header
Endress+Hauser 13



6 Parametrisation Editor ToF Tool
6.2.2 Input Window

Fig. 6: Input window in the Parameter window

The Input Window contains the parametrisation screen. This in turn consists of a graphic (if 
available) and input fields for the parameters.
The structure of the parametrisation screen is dependent on:
• the selected parameter group
• the device
• the device description

How to change a parameter value:
Within the input screen, access the input fields by clicking the mouse or the  
TAB key. You can change the value after positioning the insertion point in the input field.

How to accept a parameter value:
To accept the value, press the "ENTER" key. The value is checked for plausibility and, if correct, 
transmitted to the device. The input field is inhibited during transmission. 
If the entry is incorrect, an error message is displayed. After closing the error message, the original 
value is displayed in the input field.

How to reject a parameter value:
An input can be interrupted before pressing "ENTER" key. Simply exit the input field without 
pressing the "ENTER" key.

! Note!
Double-click the mouse on a parameter name to open the Help pages of the relevant Operating 
Instructions. Click the mouse on the graphic to open the associated Help pages.

Help window containing
the associated Operating Instructions
and description of the parameters
14 Endress+Hauser



ToF Tool 6 Parametrisation Editor
6.2.3 Footer

Fig. 7: Footer in the Parameters window

The following items are displayed in the left-hand section of the footer:
• The parametrisation group name,
• The parametrisation group number,
• The number of parametrisation screens belonging to a parameter group.

There are five buttons in the central section:
• Switch to the first parametrisation screen of a parametrisation group
• Switch to the previous parametrisation screen of a parametrisation group
• Switch to the next parametrisation screen of a parametrisation group
• Switch to the last parametrisation screen of a parametrisation group
• HOME=Switch to the first parametrisation screen of a parametrisation group
This allows you to navigate the parameter screens of a parametrisation group.

The Help icon is located in the right-hand section of the status bar. Click the Help icon to open the 
Help file for the parametrisation screen.

! Note!
Click the Help icon in the footer to open the Help pages in the appropriate Operating Instructions.
Endress+Hauser 15



7 Device List ToF Tool
7 Device List

The Device List is located at the bottom of the ToF Tool main window. The Device List offer you 
two views for the devices in the form of register cars.

Fig. 8: Device List

The following register cards are available:
• Devices

The tree device view displays the devices sorted by bus and address. You can display the 
measuring point TAG (TAGs) for every device.

• TAGs
The TAG view contains all the measuring point TAGs in a simple list.

How to open a saved Device List:

1. Click "File" and then "Open".
2. In the "Open" dialog, select the option "Search in" from the combo box. Enter the folder 

name where the Device List file is stored, and enter the name of an existing Device List in the 
Filename box.

3. Click "OK".
The Device List is loaded.

4. Double-click the mouse on an entry in the Device List or TAG view. The Parametrisation 
Editor opens.

5. Click the "Envelope Curves" button in the Navigation Bar. The Envelope Curve window 
opens. The last edited envelope curve is displayed.
16 Endress+Hauser



ToF Tool 7 Device List
7.1 "Devices" register card

The register card shows the installed devices in your workplace and also their status. They are sorted 
by bus and address.

Fig. 9: Devices register card

How to navigate the "Devices" register card:

1. Click a device. This opens the device tree in which you can see the measuring point TAG 
(TAGs) belonging to the device.

2. Double-click a device. This opens the Parametrisation Editor and an online connection to the 
device is automatically set up, as far as this is possible.

3. Click the right mouse button on a TAG. This opens a shortcut menu which contains the 
following options:
– Remove Device 
– Scan...
– Connect
– Disconnect
– Set Address
– Edit Parameters
– Upload
– Download
– Properties...
Click the identifier to start the function.

The device status is displayed using icons in the Device List:

Icon Meaning

The device is actually connected to the bus.

The device is connected (online), i.e. it is communicating with the device.

The device does not exist on the bus.

Demo Device.
Endress+Hauser 17



7 Device List ToF Tool
7.2 "TAG‘s" register card (measuring point TAG)

The register card contains the measuring point TAG (TAGs) in a simple list.

Fig. 10: TAGs register cards

How to navigate the TAGs register card:

1. Double-click a measuring point TAG. This opens the Parametrisation Editor and an online 
connection to the device is automatically set up, as far as this is possible.

2. Click the right mouse button on a TAG. This opens a shortcut menu which contains the 
following options:
– Remove Device 
– Scan...
– Connect
– Disconnect
– Set Address
– Edit Parameters
– Upload
– Download
– Properties...
Click the identifier to start the function. 

The status of the TAGs (measuring point TAG) in displayed by icons in the Device List:

Icon Meaning

The TAG is actually connected to the bus.

The TAG is connected (online), i.e. it is communicating with the device.

The TAG does not exist on the bus. 
18 Endress+Hauser
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8 Status Bar

The Status Bar is located at the bottom of the ToF Tool main window.
On the left-hand side, there are descriptions of the highlighted or activated menu options as well as 
toolbar buttons. In the centre is a progress bar, depending on the function executed. Next to the 
progress bar is a Cancel button. Click this to cancel the current action.
Endress+Hauser 19



9 Menu bar ToF Tool
9 Menu bar

Besides the standard Windows functions, the menu bar comprises additional functions for 
parameters, linearisation table and envelope curves.
The subsections below contain a detailed description of each menu.

9.1 "File" menu

The "File" menu consists of the following functions and submenus (in bold face):
• New Device List...
• Save Device List...
• Save Device List As...
• Open (CTRL+O)
• Open In Current Window ...
• Save (CTRL+S)
• Save As...
• Close
• Print... (CTRL+P)
• Print Setup...
• Create Documentation...
• View Documentation...
• Recent Device Lists

– ...
• Recent Files

– ...
• Exit

9.1.1 New Device List...

Fig. 11: New Device List... dialog box 

The dialog box for "New Device List..." opens automatically when you start ToF Tools. The dialog 
box offers four access points:

• Point to point
• Scan Bus
• Open Device List
• Show Demo Devices
20 Endress+Hauser



ToF Tool 9 Menu bar
Point to point
With a point to point connection, the selected bus is scanned and a connection is set up to the first 
device found.

Scan Bus
Scan the selected bus or all buses to regenerate the Device List. Select the bus you want to scan 
from the Device List dialog box and click the button. In the "Scan Bus" dialog box, you can change 
the selected bus if necessary and restrict the range of the device address. Click the button to scan 
the bus. The scan process starts automatically. After scanning, the dialog box displays the results of 
the scan process. The devices found on the bus are adopted automatically in the Device List. You 
can start several scan processes in succession from the dialog box.

Open Device List 
When you open a stored Device List, it shows you the last ten Device Lists used as quick selection 
list. When you load a Device List, the program checks each device to see whether it is actually 
connected to the bus. The results of this check are indicated by icons in the Device List.

Show Demo Devices
If you click the "Show Demo Devices" button, you can choose demo devices.

! Note!
You can also set up the connection later. Proceed as follows:
• Click "File" and then "New Device List...". The dialog box for "New Device List..." opens.

9.1.2 Save Device List...
This function saves the active Device List.

9.1.3 Save Device List As...
This function saves the new Device List.

Fig. 12: Save Device List dialog box
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9 Menu bar ToF Tool
9.1.4 Open (CTRL+O)
This function opens the saved Device List .

Fig. 13: Open dialog box

9.1.5 Open In Current Window ...

! Note!
You can only execute this function in Envelope Curve mode. It permits you to select and open 
stored Envelope Curves.

How to open a stored Envelope Curve:

1. Click "File" and then "Open In Current Window ...". In the "Open Envelope Curve 
Editor" dialog box, select the directory containing the Envelope Curve file from the "Search 
in:" combo box.

2. Specify the name of the existing Envelope Curve file under Filename.
3. Click "OK".

The Parametrisation Editor opens with the Envelope Curve window. The Envelope Curve window 
displays the first Envelope Curve set saved.

! Note!
When you load Envelope Curves, the program checks whether the device data (device type, 
version) in the diagram window match the data in the file. If there is no match, a warning is 
displayed (OK, Cancel). After clicking "OK", you can load the Envelope Curves data.
In Online mode, you may overwrite the Envelope Curve if you activated "Read Curve" at the same 
time. To avoid this, activate "Overlapped Curve" in the "Envelope" menu.

Fig. 14: Open Envelope Curve Editor dialog box
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ToF Tool 9 Menu bar
How to open a stored Linearisation Table:

1. Click "File" and then "Open In Current Window ...". In the "Open Table Editor" dialog 
box, select the directory containing the Table file from the "Search in:" combo box.

2. Specify the name of the existing Tabele file under Filename.
3. Click "OK".

Fig. 15: Open Tabel Editor dialog box

How to open a stored HistoROM file:

1. Click "File" and then "Open In Current Window ...". In the "Open HistoROM Editor" 
dialog box, select the directory containing the HistoROM file from the "Search in:" combo 
box.

2. Specify the name of the existing HistoROM file under Filename.
3. Click "OK".

Fig. 16: Open HistoROM Editor dialog box

9.1.6 Save (CTRL+S)

! Note!
You can only execute this function in Envelope Curve mode, Linearisation Table and HistoROM. 
This lets you save an Envelope Curve, Linearisation Table and HistoROM file.
Endress+Hauser 23



9 Menu bar ToF Tool
9.1.7 Save As...
You can only execute this function in Envelope Curve mode, Linearisation Table and HistoROM.

! Note!
The envelope curves displayed in the diagram window can be saved to a file.

How to save an Envelope Curve set:

1. Click "File" and then "Save". In the "Save" dialog box, select the directory containing the 
Envelope Curve file from the "Search in" combo box.

2. Under Filename, specify the name of the Envelope Curve Files you want to save.
3. Click "OK".
4. To save the Envelope Curve to a different folder, click another folder or New Folder. To save 

the Envelope Curve, specify a "Filename" in the Filename field and click "Save".

! Note!
If this filename already exists, a message appears and you are asked whether you want to overwrite 
the file. After confirming the message, the existing file is overwritten and the data is irretrievably 
lost. If you want to append data to an existing file, click the "Yes" button to add data.

How to save an Linearisation Table:

1. Click "File" and then "Save". In the "Save" dialog box, select the directory containing the 
Table file from the "Search in" combo box.

2. Under Filename, specify the name of the Table files you want to save.
3. Click "OK".
4. To save the Table to a different folder, click another folder or New Folder. To save the Table, 

specify a Filename in the "Filename" field and click "Save".
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How to save an HistoROM Dataset:

1. Click "File" and then "Save". In the "Save" dialog box, select the directory containing the 
HistoROM file from the "Search in" combo box.

2. Under Filename, specify the name of the HistoROM files you want to save.
3. Click "OK".
4. To save the HistoROM to a different folder, click another folder or New Folder. To save the 

HistoROM, specify a Filename in the "Filename" field and click "Save".

9.1.8 Close
This function closes the Parametrisation Editor.
Endress+Hauser 25



9 Menu bar ToF Tool
9.1.9 Print... (CTRL+P)
This function prints out the current data for the devices selected in the dialog box. You can define 
the documentation contents to suit your requirements by activating or deactivating certain 
parameters.

Fig. 17: Print dialog box
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This function prints the active Device List.

" Caution!
Before starting the print process, make sure the data are updated.

1. Click "File" and then "Print".  
2. Select the devices from the list for which you want to print the documentation contents:

– Select the devices by activating or deactivating check boxes.
– Click the "Add All" button to activate the check boxes of all devices.
– Click the "Remove all" button to deactivate all the check boxes.

3. Select the ranges you want to print:
– To print the parameters, activate the "Parameter" check box.
– To print the Envelope Curve, activate the "Envelope Curves" check box.
– To print the Linearisation Table, activate the "Table" check box.
– To print the HistoROM Dataset, activate the "HistoROM" check box.

Hinweis!
Hier müssen Sie zuerst den Reiter "HistoROM" im Navigationsfenster aktivieren, damit 
midestens ein "upload" durchgeführt wird. Die Grafik, die dann gedruckt wird, entspricht 
den zuletzt gewählten Einstellungen (x-Achse, etc.). Die Tabelle wird vollständig gedruckt.

If you want to print everything, activate all the check boxes.
You can also decide whether to print partial ranges in landscape or portrait format.

4. Activate the "Covering" check box if you want a cover page for your data.
The cover page contains the user data which you specified in "User Info…" in the "Options" 
menu. To edit the user data or enter new data, click the "User Info…" button.

5. Activate the "Device List" check box to print the Device List. 
6. If you are printing to a colour printer, activate the "Colour Printing" check box.
7. You can type in a short comment in the "Comment" input box.

9.1.10 Print Setup...
This function sets the printer options (refer to your printer description).
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9 Menu bar ToF Tool
9.1.11 Create Documentation...
This function saves the current data for the devices you selected in the dialog box in PDF format. 
You can define the documentation contents to suit your requirements by activating or deactivating 
certain parameters.

Fig. 18: Create Documentation dialog box

How to save the active device list data in PDF format:

" Caution!
Before starting the print process, make sure the data have been updated.

1. In the "File" menu, click "Create Documentation...".  
2. Select the devices from the list for which you want to generate the documentation:

– Select the devices by activating or deactivating the check boxes.
– Click the "Add All" button to activate the check boxes of all devices.
– Click the "Remove All" button to deactivate all the check boxes.

3. Select the partial ranges you want:
– To select the parameters, activate the "Parameter" check box.
– To select the envelope curves, activate the "Envelope Curves" check box.
– To select the linearisation tables, activate the "Tables" check box.
– To select the HistoROM data, activate the "HistoROM" check box.
If you want all the ranges, activate all the check boxes.
You can also decide whether to print partial ranges in landscape or portrait format.
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4. Activate the "Covering" check box if you want a cover page for your data. The cover page 
contains the user data which you specified in "User Info..." in the "Options" menu. To edit 
the user data or enter new data, click the "User Info…" button.
Company logos or similar digital data can also be entered here.

Fig. 19: User Info dialog box...

5. Activate the "Device List" check box to accept the device list. 
6. If you are printing to a colour printer, activate the "Colour Printing" check box (this is already 

activated as default).
7. You can type a short comment in the "Comment" input box.

9.1.12 View Documentation...
This function opens a documentation saved in PDF format at any time. When you open the 
documentation, Acrobat Reader starts automatically (Beispielseiten siehe nächste Seite).

Fig. 20: View Documentation dialog box
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9 Menu bar ToF Tool
Sample pages of generated documentation

m - Various signatures for device configuration, verification and approval
n - List of all device parameters
o - Illustration of the last envelope curve and its parameters read before the print process
p...r - Illustration of the linearisation table, the diagram, the tank shape and parameters

m n o

p q r
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Device parametrized

Name, Date, Signature

Device parametrization checked

Name, Date, Signature

Device parametrization released

Name, Date, Signature

EHToolShell.tof 
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Device Parameters

Device Tag Address Bus State Serial Number

Micropilot M FMR 240 LIC3235 1 Service level in safety distance -
 risk of overspill E651

1

basic setup

measured value active 143.80 %

tank shape active dome ceiling

medium property active unknown

process cond. active standard

empty calibr. active 5.000 m

full calibr. active 5.000 m

pipe diameter inactive 204.425 mm

safety settings

output on alarm active (b) MAX (22mA)

output on alarm inactive 22.00 mA

outp. echo loss active (b) hold

ramp %span/min inactive 0.000 %/min

delay time active 30 s

in safety dist. active (b) warning

safety distance active 0.100 m

ackn. alarm active no

overspill prot. active standard

linearisation

level/ullage active (a) level CU

linearisation active table on

customer unit active %

table no. active 32

input level inactive 2.000 m

input level inactive 4.749 m

input volume inactive 100.000 %

max. scale inactive 100.000 %

diameter vessel inactive 9.000 m

EHToolShell.tof: DEMO_FMR.CRV
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Envelope Curve

Device Tag Address Bus State Serial Number

Micropilot M FMR 240 LIC3235         1 Service 1

Legend

Envelope Curve Curve No. 1/4

Map Time:  24.05.2002  10:26:59

FAC

First Echo

min. Echo Quality

Comment

Envelope Parameters

measured value 20.047 %

measured dist.  2.799 m

tank shape dome ceiling

[dB]

-120.00

-110.00

-100.00

-90.00

-80.00

-70.00

-60.00

-50.00

-40.00

-30.00

-20.00

[m]0.00 0.50 1.00 1.50 2.00 2.50 3.00 3.50 4.00

E(3.40 m)F(0.40 m)

(2.80 m, -46.00 dB)
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Tables

Device Tag Address Bus State Serial Number

Micropilot M FMR 240 LIC3235 1 Service level in safety distance - 
risk of overspill E651 

1

linearis. table

Index input level (m) input volume (%)

1 0.000 0.000

2 0.065 1.183

3 0.129 2.799

4 0.194 4.888

5 0.258 7.459

6 0.323 10.369

7 0.387 13.548

8 0.452 16.948

9 0.516 20.526

10 0.581 24.259

11 0.645 28.117

12 0.710 32.076

13 0.774 36.118

14 0.839 40.220

15 0.903 44.364

16 0.968 48.532

17 1.032 52.705

18 1.097 56.867

19 1.161 60.997

20 1.226 65.079

21 1.290 69.092

22 1.355 73.015

23 1.419 76.829

24 1.484 80.507

25 1.548 84.020

26 1.613 87.342

27 1.677 90.427

28 1.742 93.218

29 1.806 95.622

30 1.871 97.527

31 1.935 98.972

32 2.000 100.000

EHToolShell.tof

ToF Tool Version 4.0

1.10.2004 11:33:42 Page 12
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P

L

D

H E
F

100%

0%

Tank Parameters

Name Value Unit

H 2.2 [m]

Empty (E) 2.2 [m]

Full (F) 2 [m]

Diameter (D) 2 [m]

Length (L) 5 [m]

Angle 5 °

End Typ (right) Flat

End Width (EW right) 0 [m]

End Typ (left) Flat

End Width (EW-left) 0 [m]

Change Position (P) 2.5 [m]
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9.1.13 Recent Device Lists
This submenu opens a list of recent Device Lists. Here you can switch to a different Device List.

9.1.14 Recent Files
This submenu opens a list of recent files. Here you can switch to a different file.

9.1.15 Exit
This function terminates the ToF Tool program.

" Caution!
Remember that before an Exit, you should save the Device List and Envelope Curves, unless you 
are sure you no longer require these data.

9.2 "Edit" menu

The "Edit" menu consists of the following functions:
• Undo (CTRL+Z)

9.2.1 Undo (CTRL+Z)
This function is used to revoke any previous function.

9.3 "View" menu

The "View" menu consists of the following functions:
• Device List
• Configuration menu
• Toolbar
• Status Bar

9.3.1 Device List
You can activate or deactivate the Device List with this function (see »Device List« on Page 16).

9.3.2 Configuration menu
You can activate or deactivate the Navigation Bar with this function (see »Navigation Window« 
on Page 11).

9.3.3 Toolbar
You can activate or deactivate the Toolbar with this function (see »Toolbar« on Page 9).

9.3.4 Status Bar
You can activate or deactivate the Status Bar with this function (see »Status Bar« on Page 19).
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9.4 "Device" Menu

The "Device" menu consists of the following functions:
• Add Demo Device
• Remove Device
• Scan... (F5)
• Connect
• Disconnect
• Set Address
• Edit Parameters
• Upload
• Download
• Properties...

9.4.1 Add Demo Device
You can add demo devices to the device list by this function.

Fig. 21: Add Demo Device dialog box

9.4.2 Remove Device 
You can remove a device from the Device List with this function. 

How to remove a device from the Device List:

1. Select a device in the Device List.
2. Click "Remove Device" in the "Device" menu. The device is removed and no longer appears 

in the device list.
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9.4.3 Scan... (F5)
You can scan the bus for new devices with this function.

Fig. 22: Scan dialog box

How to scan the bus for new devices.

1. Click the right mouse button on the window containing the Device List.
This opens a shortcut menu. Click the left mouse button on "Scan".
You can enter search criteria in the "Bus Search" dialog box.

2. Select the required bus from the "Bus" combo box. Limit the search by entering a "Start 
Address" and an "End Address".

3. Click the  "Start Scan" button to start the search. All the devices are displayed in the list and 
are adopted in the Device List.

9.4.4 Connect
This function sets up a connection to the device.

How to set up a connection to a device:
• Click the device with the right mouse button. This opens a shortcut menu. Start the "Connect" 

option. A dialog box appears during connection set-up to specify the device, the address and the 
status of the connection set-up in an icon (see page 17).

9.4.5 Disconnect
This function disconnects the device.

How to disconnect  a device:
• Click the device with the right mouse button. This opens a shortcut menu. Start the 

"Disconnect" option. The connection to the device is terminated. This status is indicated by an 
icon (see page 17).
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9.4.6 Set Address
This function sets the address of a device.

9.4.7 Edit Parameters
Return to the last edited parameter screen using this function.

9.4.8 Upload
Load all the setting parameters and envelope curves from the device and save them to the ToF Tool 
using this function.

Fig. 23: Upload dialog box

How to upload device data from the device:

1. In the Device List, select the device from which you want to load the setting 
data.

2. Click "Upload" in the "Device" menu or click the device with the right mouse button. This 
opens a shortcut menu. Select the "Upload" option.

3. Enter the filename in the "Filename" in the "Upload" dialog box. Select the "Upload Files" 
file type in the "File Type" input field. The upload file automatically receives the "*.UPL" 
filename extension.

4. Click the "Save" button to save the data. 

The data transmission status is indicated in a progress bar.
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9.4.9 Download
The parameters saved in the ToF Tool can be loaded into the device either fully or partly.

Fig. 24: Download dialog box

How to download the setting parameters from the ToF Tool to the device:

1. In the Device List, select the device to which you want to load the setting data.
2. Click "Download" in the "Device" menu or click the device with the right mouse button. This 

opens a shortcut menu. Select the "Download" option.
3. Enter the folder and the filename in the "Download" dialog. 
4. Activate the "Selective Download" check box if you only want to execute a partial download.
5. For a partial download, select the download group from the "Section" list. This is the group 

you want to transmit to the device. 
6. Click the "Download" button, to start transmission.

The data transmission status in indicated in a progress bar.

! Note!
The download groups shown in the list are defined in the Device Description and are therefore 
dependent on the device and the device description. Only one download group can be selected at 
a time for a download.

Fig. 25: Download dialog box
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9.4.10 Properties...
This function displays the device properties (such as device type, version, bus, address and serial 
number).

Fig. 26: Properties... dialog box
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9.5 "Options" menu

The "Options" menu consists of the following functions:
• Settings...
• User Info...
• View Log...
• Modem Address
• Dial Up

9.5.1 Settings...

Settings for serial connections
The assignment of a serial connection to a communications protocol (IPC, HART) during ToF Tools 
installation can be modified in ToF Tool.

Fig. 27: Settings... dialog box

How to change the assignment of serial connections:

1. Click "Settings…" in the "Options" menu.
2. In the "Settings…" dialog, select the bus to which you want to assign a serial connection from 

the "Service/HART" list.
3. Select the serial connection from the "COM-Port" combo box.

You can also set the parameters, such as preamble number, master type, etc.
4. Then click "OK"
5. Restart the ToF Tool.
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Settings for the PROFIBUS-interface DPV1
You can set up the PROFIBUS-interface DPV1 in the "DPV1" combo box.

Fig. 28: Settings/DPV1 dialog box

ToF Tool language
The language setting selected during installation of the ToF Tool can be modified in the ToF Tool.

Fig. 29: Settings/Language dialog box
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How to change the ToF Tool language:

1. Click "Settings..." in the "Options" menu.
2. In the "Settings…" dialog box, select the language for ToF Tool in the "Language" combo 

box.
3. Then click "OK".
4. Restart the ToF Tool.

! Note!
All languages selected during the installation are displayed in the "Language" combo box. If one of 
the possible ToF Tool languages is missing from the combo box, it can also be installed (refer to 
Installation Instructions of ToF Tool).

Logging
You can set up a log file in the "Logging" combo box.

Fig. 30: Settings/Logging dialog box
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Directories
You can set up the paths of the ToF Tool files in the "Directories" combo box.

Fig. 31: Settings/Directories dialog box
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9.5.2 User Info...
With this function you can enter the User Info (such as company, user, address, etc.).

Fig. 32: User Info... dialog box

9.5.3 View Log...
You can display the log file by this function.

Fig. 33: View Log dialog box
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9.5.4 Modem Address
You can set up a modem connection by this function.

Fig. 34: Modem Address dialog box

Fig. 35: Connection via Friesia modem

Order information: The analog HART modem (Type: HMA02) can be ordered from Friesia under 
the following email address: friesia@t-online.com

-

+
ToF Tool -
FieldTool
Package

standard modem
Insys Pocket 336

HMA 02
Friesia
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9.5.5 Dial Up
You can dial up the set up modem connection by this function.

Fig. 36: Dial Up dialog box
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9.6 "Parameter" menu

The "Parameter" menu consists of the following functions:
• History Back
• History Forward

9.6.1 History Back
You can move back page by page in the Parameters dialog box using this function. You can perform 
the same function by clicking the button in the bottom bar in the 
Parameters dialog box.

9.6.2 History Forward
You can move forward page by page in the Parameters dialog box using this function.
You can perform the same function by clicking the button in the bottom bar in the 
Parameters dialog box.

9.6.3 Edit Header Parameters
You can use this function to specify which device parameters are permanently displayed in the 
“Header area” of the headline in the parameterisation view. In addition, locking statuses can be 
individually displayed in the headline as “prominent parameters”.

Fig. 37: Device parameter display in the headline

Header ParameterProminent Parameter
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How to add device parameters to the Header area:

1. Using the left mouse button, select a device parameter in the directory structure.
2. Click the ”>” button to copy this parameter to the picklist.
3. The parameters listed in the picklist are permanently displayed in the “Header area” of the 

parameterisation view (see Fig. 37). This setting is saved in the ToF Tool for every device type 
(e.g. FMR, FMU, FMP, etc.). Each time you start the program, this information is then available 
for the device selected for configuration from the device list.

! Note!
The settings made in the “Select Header Parameters” dialog box are saved for every device type (e.g. 
FMR, FMU, FMP, etc.) in the ToF Tool. Each time you start the ToF Tool, this information is then 
available for the device selected for configuration from the device list and is displayed in the Header 
area.

How to remove device parameters from the Header area:

1. Using the left mouse button, select a device parameter in the directory structure from the 
picklist. Use the CTRL key and the left mouse button to select more than one parameter.

2. Click the “<” button to remove this parameter from the picklist.

! Note!
You can use the “Defaults” button to reset the picklist to the standard measured value, output 
current and measured distance parameters.

Prominent parameters:
Locking statuses (e.g. overspill protection, release code) can also be displayed individually as 
“Prominent Parameters” in the headline. Only permitted parameters can be copied to the selection 
window with the “>” button. You can remove this parameter again with the “<” button.
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9.7 "Table" menu

! Note!
When the Table window is active, the "Table" menu is part of the main menu in the menu bar.

You can create, edit, import and export a linearisation table using this menu.

The "Table" menu consists of the following functions:
• Insert Row (Ins)
• Remove Selected Rows (Del)
• Clear Selected Rows
• Clear All Rows
• Edit Cell (F2)
• Export
• Import
• Show Table
• Run QH Program

9.7.1 Linearisation Table dialog window
The Linearisation Table window consists of:
• Table with the buttons: Read/Write
• Input field for the volume unit
• Footer, which indicates instrument name and type, TAG-number, state.
• Diagram (see Fig. 40)

Fig. 38: Dialogfenster - Linearisierungstabelle: Diagramm
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or of:

• Table with the buttons: Read/Write
• Input field for the volume unit
• Footer, which indicates instrument name and type, TAG-number, state.
• Selection and calculation form for the tank shape (see Fig.41)

Fig. 39: Dialogfenster - Linearisierungstabelle: Tank

How to edit the tank shape:

1. Select the tank shape from the selection window and enter the appropriate dimensions.
2. Select the customer unit from the selection window.
3. Click on the "Calculate Table" button.
4. Thereafter, click on the "Write" button.

The calculated values are automatically transfered to the table.

How to read and write a linearisation table

1. Click on the "Read" button in order to read a linearisation table from the instrument to the table 
editor.

2. Click on the "Write" button in order to write a linearisation table from the table editor to the 
instrument.
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Table Toolbar
The Table Toolbar contains the following icons:

9.7.2 Linearisation - pressure devices
The linearisation table is used solely for non-linear level measurement. For this reason, the table can 
only be configured for the “Level” measuring mode (apart from LEVEL MODE=linear).

How to activate a linearisation table for pressure devices:

1. For the “MEASURING MODE” function, select the “Level” parameter.

Fig. 40: Dialog window - parameter

Icon Meaning

"Export Table" button

"Import Table" button

"Display Table" button
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2. For the “LEVEL MODE” function, select the “Pressure linearized” or “Height 
Linearized” parameter.

Fig. 41: Dialogf window - parameter

3. Now you can edit the linearisation table and different tank shapes (at parameter "Height 
Linearized" only).

9.7.3 Insert Row (Ins)
You can insert a row in the linearisation table with this function.

9.7.4 Remove Selected Rows (Del)
You can delete the highlighted row in the linearisation table with this function. You can select 
multiple rows with the mouse and delete them by pressing the DEL key.

9.7.5 Clear Selected Rows
You can clear the contents of the selected rows with this function.

9.7.6 Clear All Rows
You can clear all the rows with this function.

9.7.7 Edit Cell (F2)
This function allows you to edit cells. You can also edit a particular cell by double-clicking the 
appropriate cell with the mouse.
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9.7.8 Export
You can save a linearisation table from the table editor to a file (type *.csv) using this function.

Fig. 42: Export dialog box

9.7.9 Import
You can load a linearisation table from a file (type *.csv) to the table editor using this function.

" Caution!
After importing the table is not yet present in the instrument. Use the "Write" button in the 
"Linearisation table" dialog window, to write the function from the table editor to the instrument 
(see Page 46).

Fig. 43: Export dialog box

9.7.10 Show Table
You can switch on and off the table by this function. If the table is switched off, only the linearisation 
diagram is displayed.
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9.7.11 Run QH Program
By this function, you can start the QH program, which is used to calculate typical QH curves for 
different weirs and flumes.

! Note!
The QH program can also be started directly from the "QH" button in the toolbar.

! Note!
The QH program can only be started, if Excel (Version 97 or higher) is installed on your computer.

! Note!
The QH program contains Excel macros. Therefore, on starting up a warning message is displayed 
which has to be confirmed by "Yes".

User Interface of the QH Program

The user interface of the QH program consists of
• the Data Sheet

all parameters of the selected weir or flume are displayed here as well as the resulting QH curve.
• the Operating Buttons

The individual operating procedures are described in the following sections.
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Selecting a language

1. Press the "Sprache waehlen/Select Language" button on the right next to the form.
2. Select the desired language version.

3. Confirm your selection and exit the input window by pressing "OK".
The form and the operating buttons appear in the selected language.

Entering header data

1. Press the "Header data" button on the right next to the form.
2. Enter your data. You can jump between fields by pressing "Tab".

3. Confirm your entry and exit the input window by pressing "OK".
The data entered are transferred to the header field on the form.
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Selecting an application

1. Press the "New application" button on the right next to the form.
2. Select the desired application.

3. Confirm your selection by pressing "OK".
A second input window "input parameters" then appears automatically and requests the 
application specific parameters. This window also can be accessed directly by clicking on the 
"Change application" button.

Changing an application

1. Press the "Change application" button on the right next to the form.
2. Enter the application specific parameters of your weir or flume.

– The fiels "Inputs necessary for calculation" must be filled in completely.
– "Inputs only for information" are not included in the calculation and therefore are optional.
– The "Relations" specify the conditions under which an optimal measurement is assured. The 

QH curve will also be calculated if the data entered do not meet these conditions.
3. Confirm your entry and exit the input window by pressing "OK".

– The entered parameters are accepted and displayed in the relevant fields in the form.
– The QH curve of the weir or flume is calculated and displayed in the form as a table and as 

a diagram.
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Saving a table

1. Press the "Save table" button on the right next to the form.
2. Select the instrument for which you want to use the QH curve:

– Prosonic T: 11 points
– Prosonic / Prosonic M: 32 points

3. Confirm your selction by pressing "OK". The Windows input window "Save as" the opens 
automatically.

4. Save the table to your target directory.

Loading a table to the instrument

1. Close the QH program.
2. Open the "Linearisation table" dialog window (via the "Linearisation table" button in the 

navigation bar).
3. Use the "Import" function of the "Table" menu to load the new linearisation table into the 

table editor (see Page 50).
4. Click on the "Write" button in the "Linearisation table" dialog window in order to write the 

table to the instrument (see Page 46).
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9.8 "Envelope Curve" menu

! Note!
When the Envelope Curve window is active, the "Envelope Curve" menu is part of the main menu 
in the menu bar.

The "Envelope Curve" menu consists of the following functions and submenus (in bold face):
• Read Curve
• Cyclic Read
• Read MAP
• End Read
• Read Settings...
• Cyclic Read Settings...
• Reset Reading Range
• Edit Parameter List
• Overlapped Curve
• "Play Back" submenu

– Selected Curves...
– Forward
– Fast Forward
– Reverse
– Fast Reverse
– Stop
– Pause

• "Display" submenu
– Clear Plot Display
– Zoom and Grid Settings...
– Reset Zoom Area
– Undo Zoom
– First Envelope Curve
– Last Envelope Curve
– Next Envelope Curve
– Previous Envelope Curve

• Extract...
• Export To File...
• Import Curve from upload file...
• Export Curve to upload file...
• Remarks...
• Load Ideal Echo
• Move Ideal Echo to Peak
• "Set Cursor" submenu

– Cursor 1
– Cursor 2
– Edit Curve under Cursor (Ctrl+E)
– Free
– Envelope Curve
– MAP
– FAC
– Ideal Echo

• "Layout" submenu
– All
– Diagram
– Diagram+Parameters
– Diagram+Info
– Parameters
– Parameters+Info
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9.8.1 Elements of the Envelope Curve window

Fig. 44: Envelope Curve window

The Envelope Curve dialog window consists of:
• Envelope Curves Toolbar
• Diagram window
• Parameter list
• Envelope Curve List
• Data at Cursor Position
• Device data
• Curves data
• Remarks

Envelope Curves Toolbar
The Envelope Curves Toolbar contains icons for navigating saved envelope curves and allows you 
quick access to commands.
The Envelope Curves Toolbar contains the following icons:

Envelope Curves Toolbar Diagram window Parameter List

Data at Cursor Position
Device data:

Remarks Envelope Curves

Envelope Curve List

e.g. State of the device
(current error message) data
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Icon Meaning

"First" button goes to first saved Envelope Curve File.

"Previous" button goes to previous Envelope Curve File. Only active if the previous record exists.

"Next" button goes to next Envelope Curve File. Only active if the next record exists.

"Last" button goes to last Envelope Curve File.

"Read" button records the present envelope curve.

"Read" button requests the next Envelope Curve File from the Online Device.

"Cancel Read" cancels transfer of the Envelope Curve. Data already transferred are discarded.

"Read Settings" button opens a dialog box to edit read options for an 
Envelope Curve.

"Cyclic Read" button executes a cyclical request for the next Envelope Curve File at 
predefined intervals.

"Cyclic Read Settings" button opens a dialog box for making settings for Cyclic Read.

"Reset Zoom" button resets the zoom area to the standard settings.

"Reset Reading" button resets the reading range to the standard settings.

"Undo Zoom" button resets the zoom area by one step.

"Display" button opens a dialog box for entering criteria to display 
saved Envelope Curve data.

"Play-Back Fast Reverse" jumps backwards to the first of the recorded curves.

"Play-Back Reverse" button displays the recorded envelope curves in reverse order.

"Stop Play-Back" button terminates the play-back. In order to display the recorded curves again click 
on "Play-Back".

"Pause Play-Back" interrupts the play-back. In order to continue the display in the selected direction, 
click on the button again.

"Play-Back" button displays the recorded envelope curves in forward direction.

"Play-Back Fast Forward" button jumps forward to the last of the recorded envelope curves.
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Diagram window
The envelope curves are displayed in the Diagram window. The scales are on the left-hand side and 
at the bottom. The minimum and maximum scale values are determined in the device description 
and are therefore dependent on the device and the device description. In a drawn envelope curve, 
the following values are displayed:
• Empty calibr.
• Full calibr.

The envelope curves can be measured using the cursors. The values at the cursor position are shown 
in the Data At Cursor Position window. Displayed envelope curves can be shown or hidden. You 
can also overlap several Envelope Curve Sets.

"Parameter" List
The Parameter List is located on the right-hand side of the Envelope Curve window. The Parameter 
List is automatically generated from the device description and is therefore dependent on the device 
and the device description. When reading an Envelope Curve file the current parameter values are 
read and displayed (in Online mode). In Offline mode, the saved data are displayed.

Envelope Curve List
The Envelope Curve List contains the envelope curves which can be edited. Use this list to select 
the envelope curves for transmission. The selected envelope curves are transmitted with the Read 
request from the device.
To make the graphic more manageable, the envelope curves can be switched on and off.

" Caution!
At the next Read request, the deactivated envelope curves are no longer read!

Activate the check box of the envelope curves you want to read and display. Deactivate the check 
box of the envelope curves which you do not want to either display or read.

Data at Cursor Position
The data at the cursor position are displayed in this field.
• Cursor 1:X and Y - Value
• Cursor 2:X and Y - Value
• Diff.: from Cursor 2 and Cursor 1
• Ideal echo-dist.:

Device data
Saved device data are displayed in this dialog window:
• Device name:
• Tag name:
• Status:
• Serial Number:

! Note!
This window is for information purposes only. 
58 Endress+Hauser



ToF Tool 9 Menu bar
Curve Data
The following information is displayed in this dialog window:
• Number of saved envelope curves and number of displayed curves
• Date / Time at which the displayed curve was generated
• Time remaining

! Note!
This dialog window is for information purposes only. 

Remarks...
Remarks can be added to envelope curve files and saved with the envelope curves.

How you enter remarks:

1. Click the button on the right in the Envelope Curve dialog window. A window opens for you 
to enter your remarks.

2. Click "OK". The remarks are accepted.

The remarks are displayed automatically when you load an envelope curve which was saved with 
remarks.
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9.9 Envelope Curve window

Fig. 45: Envelope Curve window

How to open the Envelope Curve window in Online mode:

1. Double-click the mouse on an entry in the Device List or TAG view. The Parametrisation 
Editor opens.

2. Click the "Envelope Curves" button in the Navigation Bar. The Envelope Curve window 
opens. The empty values are read in the background to define the default values for the Read 
parameters. The X-axis value is set from the given value as follows:
Xmin= 0
Xmax= empty value + 20%
Xdelta= empty value / (maxCurveLen / 10)

How to open the Envelope Curve dialog window in Offline mode (e.g. to load a saved 
envelope curve):

1. Click "Open" in the "File" menu.
2. In the "Open" dialog box, select the directory containing the Envelope Curve File from the 

"Search in" shortcut menu, enter the name of an existing envelope curve file in the filename 
box. 

3. Click "OK".

The Parametrisation Editor opens with the Envelope Curve dialog window. The Envelope Curve 
window displays the first curve set saved.
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9.9.1 Read Curve
This function allows you to request the next envelope curve file from the online device.

9.9.2 Cyclic Read
This function executes a cyclical request for the next envelope curve file at predefined intervals.

9.9.3 Read MAP
The MAP from the online device is read and dislayed by this function.

9.9.4 End Read
The reading procedure is terminated by this function.

9.9.5 Read Settings...

Fig. 46: Read Settings... dialog box

You can change the read options for the envelope curve with this function.

How to change the envelope curve read settings:

1. Click "Read Settings" in the "Envelope Curve" menu or the "Read Settings" button in the 
toolbar.

2. Enter the start and end values in the "Range" dialog box.
3. Use the slide bar to set the number of read data points.
4. By activating the check box, you can determine whether to read only the envelope curve, the 

FAC (Floating Average Curve) or both.
5. To accept the settings, click the "OK" button.

To read them, click the "Read Now" button.
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The values in the displayed area define the segment of the envelope curve and the appearance of 
the X axis in the diagram window.
The position of the slide bar determines the number of read data points. The position of the slide 
bar has the following effect:
High = 100% means that the maximum number of data points is read. The number is defined by 
the device and the corresponding device description.
Medium = 50% means that 10% of the maximum number of data points are read.
Low = 0% means that 1% of the maximum number of data points are read.
The points in between are calculated exponentially.

The Y resolution has the following settings:
Slide bar <= 50% : 6 bit resolution
Slide bar >= 50% : 8 bit resolution 

9.9.6 Cyclic Read Settings...

Fig. 47: Cyclic Read Settings... dialog box

You can change the read options for cyclic reading envelope curves with this function.

How to change the envelope curve read parameters for Cyclic Read:

1. Use the "Cyclic Read Settings..." dialog box to define the cycle time, events and the 
operations used for cyclic reading and saving the envelope curve. The options you set are 
effective for the current version of ToF Tools.

2. Click "Cyclic Read Settings..." in the Envelope Curve menu or the button in the toolbar to 
change the settings.
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You can set the following settings and events in the "Cyclic Read Settings" dialog box:
• Time

Here, specify the time between the envelope curve updates in seconds, e.g.:
– 2 s = the envelope curve is updated every 2 seconds,
– 0 s = envelope curve is updated permanently.

• Conditional Time
You can only make an entry in this row if the "Evaluate Condition" check box is activated. The 
cycle time entered here is only valid if the dependencies entered in "Conditions" are true. The 
"Conditional Time" replaces the above-mentioned time.

9.9.7 Reset Reading Range
You can reset the reading range to the standard value of the respective device by this function.

9.9.8 Edit Parameter List
You can add or remove parameters to/from the parameter list by this function.

9.9.9 Overlapped Curve
This function allows you to cascade sets of envelope curves in the Diagram dialog box.

How to cascade the envelope curves displayed in the Diagram dialog box:
The envelope curves shown in the Diagram dialog box are deleted when a new envelope curve is 
read. If you want to insert a new envelope curve in the Diagram dialog box without deleting the 
one currently on display, proceed as follows:

1. In the "Envelope Curve" menu, activate the "Overlapped Curve" option (this is indicated 
by a check mark).

2. Click "Read Curve" in the "Envelope Curve" menu. The new envelope curve is displayed in 
the same Diagram window as the previously read envelope curve. By repeating this process 
several times, you can display several envelope curves cascaded in a Diagram window.
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9.10 "Play Back" submenu

The "Play Back" submenu consists of the following functions.

9.10.1 Selected Curves...

Fig. 48: Display Envelope Curve... dialog box

Using this function you can open a dialog which offers a number of criteria for use with saved 
envelope curves to display a subgroup of envelope curve sets.

How to adapt criteria to display a subgroup of envelope curve sets:
• In the "Envelope" menu, click "Display Envelope Curves...". A filter windows opens for you 

to generate the following filter criteria:
– according to numbers
– according to date and time
– according to parameter value

! Note!
Filter operations are applied to saved envelope curve sets. When envelope curves are transmitted 
(individual or cyclic), no filter operations can be carried out. 

How to set a filter criterion for use with curve sets:

1. Click the left mouse button on a radio button for which you want to set a criterion and enter 
the value in the input field.

2. Click the "OK" button with the left mouse button.
You can display the required envelope curve sets with the navigation buttons.
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According to numbers
For the "according to numbers" filter criterion, you can enter numbers from the saved envelope 
curve sets as the argument. When doing so, remember to enter the numbers in ascending order.

By date and time
If you want to enter a date or time-related criteria, enter a date or time value as the argument. If 
you want to limit a range, enter a date and time value in the "from-to" input fields.
Enter the date and time values in ascending order.

According to parameter value
You can enter several parameters in the "according to parameter value" criterion. Make sure that 
the parameters are correctly linked to a valid query. In a query, parameters can be linked by one of 
the two key words: "AND" or "OR". 
The following comparison operators are permitted for the parameters (<, >, <>, <= , >= and 
unequal).

9.10.2 Forward
This function displays the selected curves in forward direction.

9.10.3 Fast Forward
By this function you jump to the last of the selected envelope curves.

9.10.4 Reverse
This function displays the selected curves in backward direction.

9.10.5 Fast Reverse
By this function you jump to the first of the selected envelope curves.

9.10.6 Stop
This function stops the play back. In order to start a new play back click on "Play Back" again.

9.10.7 Pause
This function interrupts the play back. In order to resume the play back in the selected direction, 
click on "Pause" again.
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9.11 "Display" submenu

The "Display" submenu consists of the following functions.

9.11.1 Clear Plot Display
You can delete all the envelope curves in the Diagram dialog box with this function.

How to delete the envelope curves shown in the Diagram dialog box:
• In the "Envelope" menu, click "Clear Plot Display". This deletes the envelope curves displayed 

in the Diagram dialog box:

! Note!
Only the envelope curves displayed in the Diagram dialog box are deleted. This command has no 
influence on previously saved envelope curves.

9.11.2 Zoom and Grid Settings...
You can adjust the zoom and grid settings to your needs by this function.

9.11.3 Reset Zoom Area
This function resets the zoom area to the standard value.

9.11.4 Undo Zoom
This function resets the zoom area by one zoom step.

9.11.5 First Envelope Curve
Using this function, you can switch to the first envelope curve set saved in an envelope curve file.

9.11.6 Last Envelope Curve
Using this function, you can switch to the last envelope curve set saved in an envelope curve file.

9.11.7 Next Envelope Curve
Using this function, you can switch to the next envelope curve set saved in an envelope curve file.

9.11.8 Previous Envelope Curve
Using this function, you can switch to the previous envelope curve set saved in an envelope curve 
file.
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9.11.9 Extract...

Fig. 49: Extract dialog box

This function opens a dialog box which offers a number of criteria for use with saved envelope 
curves, to sort envelope curve sets.

How to adapt criteria to sort envelope curve sets:
• Click "Extract..." in the "Envelope Curve" menu. A filter dialog box opens giving you the 

possibility of creating the following filter criteria:
– according to number
– according to date and time
– according to parameter value

! Note!
Filter operations are applied to saved envelope curve sets. During transmission (individual or cyclic) 
of envelope curves, no filter operations can be carried out. 

How to set a filter criterion for use with curve sets:

1. Click the left mouse button on a radio button for which you want to set a criterion and enter 
the value in the input field.

2. Click the "OK" button with the left mouse button.
You can display the required envelope curve sets with the navigation buttons.

According to number
For the "according to number" filter criterion, you can enter numbers from the saved envelope 
curve sets as the argument. When doing so, remember to enter the numbers in ascending order.

According to date and time
If you want to enter a date or time-related criteria, enter a date or time value as the argument. If 
you want to limit a range, enter a date and time value in the "from-to" input fields.
Enter the date and time values in ascending order.
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According to parameter value
You can enter several parameters in the "according to parameter value" criterion. Make sure that 
the parameters are correctly linked to a valid query. In a query, parameters can be linked by one of 
the two key words: "AND" or "OR".
The following comparison operators are permitted for the parameters (<, >, <>, <= , >= and 
unequal).

9.11.10 Export To File...
You can use this function to export the set of envelope curves into a *.csv file.

Fig. 50: Export To File dialog box
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9.11.11 Import Curve from upload file...
With this function, you can import the MAP from an upload file (*.upl file).
You can then edit this MAP in the envelope curve window (to map an additional interference echo). 
You cannot edit the MAP directly in the device.

" Caution!
This function can only be executed with devices with software version 2.0 and higher!

How to import a curve from the upload file:

! Note!
You first have to create an upload file (for a description, see "Upload" on Page 34).

1. In the "Envelope Curve" menu, select the "Import MAP from Upload File..." function. The 
appropriate curve is displayed in the diagram window.

2. You can edit this curve (for a description, see "Edit Curve under Cursor (Ctrl+E)" on Page 72).
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9.11.12 Export Curve to upload file...
With this function, you can export the edited MAP back to the upload file (*.upl file).
You can then load this upload file back into a device. The new MAP then becomes effective for this 
device.

How to export a curve back to the upload file:

1. In the "Envelope Curve" menu, select the "Export MAP to Upload File..." function.
2. Select the appropriate upload file (file name.upl) and click "Save".

3. You can load this upload file to the device (for a description, see "Download" on Page 35).

9.11.13 Remarks...

Fig. 51: Remarks... dialog box

This function allows you to add a remark to an envelope curve files and save it with the curve set.

How to add a remark to an envelope curve file:

1. Click the button on the right-hand side of the "Envelope Curve dialog window".
2. Click "Remarks..." in the "Envelope Curve" menu. A dialog opens in which you can enter 

your remarks.
3. Click "OK". The remarks are accepted. The remarks are displayed automatically when you load 

an envelope curve which was saved with remarks.
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9.11.14 Load Ideal Echo
You can import an ideal envelope curve from a *.csv file by this function.

Fig. 52: Load Ideal Echo Curve... dialog box

9.11.15 Move Ideal Echo to Peak
Moves the ideal echo curve to the peak of the envelope curve.
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9.12 "Set Cursor" submenu

The "Set Cursor" submenu contains the following functions.

General information
The envelope curves displayed in the diagram window can be measured with two cursors. The 
cursor can be positioned using the mouse or the keyboard.

How to position a cursor in the diagram window

1. Using the right mouse button, click the diagram window. This displays a context menu from 
which you can select cursor 1 or cursor 2 as the current cursor. The current cursor is indicated 
in the context menu with a check-mark. In addition, you can decide whether the cursor is 
positioned freely, on the envelope curve, MAP or FAC.

2. In the diagram window, position the cursor at one position (free, envelope curve, MAP, FAC) 
and left-click the mouse at this position. The cursor is displayed and the current values are 
displayed in the “Data at Cursor Position” information screen.
To display the cursor with the keyboard, press the CTRL and the TO-RIGHT key at the same 
time.

3. You can switch between cursors and specify a cursor as the current cursor by clicking the 
diagram window with the right mouse button and then specifying the current cursor in the 
context menu displayed. This is then indicated with a check-mark.

9.12.1 Cursor 1
You can position cursor 1 within the document window by this function.

9.12.2 Cursor 2
You can position cursor 2 within the document window by this function.

9.12.3 Edit Curve under Cursor (Ctrl+E)
This function takes you to the edit mode for the mapping. In this mode you can use the cursor to 
move single points of the mapping curve within the diagram window.

! Note!
You cannot alter the mapping directly in the device. Only mapping curves imported from an upload 
file (with the aid of the "Import Curve from Upload File" function) can be edited. Once you have 
finished editing, write your changes back into the upload file with the "Export Curve to Upload File" 
function. The new mapping curve takes effect once you have downloaded this file to a device 
(Download).
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How to edit a MAP in the envelope curve window:

" Caution!
This function can only be executed with devices with software version 2.0 and higher!

1. First generate an upload file. In the "Devices" menu, left-click "Upload".
2. Select a directory and file name (file name.upl) and left-click the "Save" button.

3. Left-click the "Upload" button to start the process.

4. The upload has been successful. Using the left mouse button, click the "OK" button.
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5. In the "Envelope Curve" menu, select the "Import MAP from Upload File..." function to 
edit a MAP. The appropriate MAP is displayed in the diagram window.

6. Position the cursor in the diagram window. Right-click the mouse and select the "Edit Curve 
under Cursor (Ctrl+E)" option in the dialog window. The background colour in the diagram 
window changes from "Yellow" to "Green". You can now edit the curve in the diagram 
window.
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7. The following functions are available to edit the MAP within the diagram window:
– Double-click the left mouse button to position the points to be edited on the curve. These 

are indicated by a square.
– Left-click an editing point and hold down the mouse key. This is how you move this point 

along the Y-axis.
– Double-clicking with the left mouse button between two editing points above or below the 

curve sets a new editing point and redraws the curve between these three points.

8. Position the cursor in the diagram window. Right-click the mouse and select the "Edit Curve 
under Cursor (Ctrl+E)" option in the dialog window. The background colour in the diagram 
window changes from "Green" to "Yellow". You can now no longer edit the curve in the 
diagram window.

9. In the "Envelope Curve" menu, select the "Export MAP to Upload File..." function to 
export an edited MAP to the upload file.
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10. Select the appropriate upload file (file name.upl) and click "Save".

11. You can now load the appropriate upload file with the edited MAP into the device.
12. In the "Device" menu, left-click "Download".
13. Select the appropriate download file and use the left mouse button to click "Open".
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14. Using the left mouse button, click the "Download" button.
For selective download, see the description on Page 35.

15. An information screen tells you that the device parameters will be completely or partially 
overwritten. If you agree to this overwriting, use the left mouse button to click "OK".

16. The download has now been successful. Using the left mouse button, click the "OK" button.
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9.12.4 Free
If you select this function, you can freely position the activated cursor in the diagram window. The 
corresponding cursor data are shown in the analysis window beneath the envelope curve.

Fig. 53: Envelope curve screen: cursor1=free and cursor2=free

9.12.5 Envelope Curve
If you select this function, you can position the activated cursor along the curve type selected. When 
positioning the cursor, you can combine the curve types (here envelope curve-envelope curve) to 
analyse differences.

Fig. 54: Envelope curve screen: cursor1=envelope curve and cursor2=envelope curve
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9.12.6 MAP
If you select this function, you can position the activated cursor along the curve type selected. When 
positioning the cursor, you can combine the curve types (here envelope curve-MAP) to analyse 
differences.

Fig. 55: Envelope curve screen: cursor1=envelope curve and cursor2=MAP

9.12.7 FAC
If you select this function, you can position the activated cursor along the curve type selected. When 
positioning the cursor, you can combine the curve types (here envelope curve-FAC) to analyse 
differences.

Fig. 56: Envelope curve screen: cursor1=envelope curve and cursor2=FAC
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9.12.8 Ideal Echo
If you select this function, you can position the activated cursor along the curve type selected. When 
positioning the cursor, you can combine the curve types (here envelope curve-ideal echo) to analyse 
differences.

Fig. 57: Envelope curve screen: cursor1=envelope curve and cursor2=ideal echo
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9.13 "Layout" submenu

The "Layout" submenu contains the following functions.

9.13.1 All
With this function, all informations are displayed in the Envelope dialog window.

9.13.2 Diagram
With this function, only the diagram window is displayed in the Envelope dialog window.

9.13.3 Diagram+Parameters
With this function, the diagram window and the parameters are displayed in the Envelope dialog 
window.

9.13.4 Diagram+Info
With this function, the diagram window and the envelope curve information are displayed in the 
Envelpe dialog window.

9.13.5 Parameters
With this function, only the parameters are displayed in the Envelope dialog window.

9.13.6 Parameters+Info
With this function, the parameters and the envelope curve information are displayed in the 
Envelope dialog window.
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9.14 "HistoROM" menu

! Note!
When the HistoROM screen is active, the ”HistoROM” menu is an integral part of the main menu 
in the menu bar.

The “HistoROM” menu consists of the following functions:
• Upload (from device)

9.14.1 HistoROM/M-Dat
HistoROM/M-Dat is a memory module which is attached to the electronic insert and fulfills the 
following functions:
• Copying configuration data of a transmitter into another transmitter
• Cyclic recording of pressure and sensor-temperature measured values
• Recording diverse events, such as alarms, counters for exceeding of the sensor range for pressure 

and temperature, exceeding the user limits for pressure and temperature, etc.

9.14.2 HistoROM editor
The HistoROM editor is used to graphically visualise the HistoROM data.
There are two kinds of display in the ToF Tool:
• As a HistoROM diagram
• As a HistoROM event table
82 Endress+Hauser



ToF Tool 9 Menu bar
9.14.3 HistoROM diagram
The information stored in the device can be displayed graphically, as a curve, in the HistoROM 
diagram. Each curve is assigned its own scale. A flag is displayed above the X-scale for every event 
in the time window. The operated hours counter and the assigned system time when uploading 
started are also displayed in the diagram.

Fig. 58: Display screen - HistoROM: diagram

Scaling and labelling the axes
The X-axis is scaled for the time range of 25 hours; the more recent date is on the right-hand side 
of the scale. If possible, the axis is labelled with information on the date and time. This means that 
the hours of operation stored in the device are converted into time data using the current PC date 
and time.

If the HistoROM editor detects a “Device On” event, a time cannot be assigned to the events that 
come before this. For this reason, the labelling of the X-axis changes in the graphic as of this point. 
Instead of displaying the date and time, only the operation time counter is displayed (in seconds).
The scaling of the Y-axis refers to the units set in the device.

Each curve is assigned a scale. The scaling in the pressure scale displays the “lower normal operating 
range limit - 10%” to “upper normal operating range limit + 10%” range. The parameters for the 
upper and lower normal operating range limit are determined from the sensor range. The scaling in 
the temperature scale displays the “sensor temperature min - 10%” to “sensor temperature max + 
10%” range.
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Limit values
In the measured value diagram, the limit values of the device are shown as dotted lines. The 
following limit values are displayed as standard:
• Lower normal operating range limit
• Upper normal operating range limit
• Customised limit Pmin process
• Customised limit Pmax process
• Lower normal operating range limit, temperature
• Upper normal operating range limit, temperature
• Customised limit Tmin process
• Customised limit Tmax process

Displaying and hiding curves and limit values
Proceed as follows to hide or display curves and limit values:

1. Move the cursor in the area of the HistoROM diagram and click with the right mouse button. 
The following dialog box is displayed:

2. You can create the following views by selecting the corresponding menu item:
– Pressure and temperature = Pressure and temperature curve with pressure and temperature 

limit values
– Pressure only = Pressure pattern with pressure limit value display
– Temperature only = Temperature pattern with temperature limit value display

Zoom
You have the option of enlarging (zooming) a defined area of the HistoROM diagram on the X-axis 
and Y-axis. Proceed as follows to zoom in on a defined area:

1. Move the cursor in the area of the HistoROM diagram. Hold down the left mouse button to 
select a rectangular area within the HistoROM diagram which should be enlarged. The 
labelling of the axis is adjusted according to the enlarged area. At least 4 data points will be 
visible in the X-direction, i.e. the X-axis displays a range of 1 hour.

2. If you want to undo this selection, place the cursor in the area of the HistoROM diagram and 
click with the right mouse button. The following dialog box is displayed:

3. Select the “Reset Zoom Area” menu item to reset the zoom.

! Note!
The zoom area can only be selected with the mouse; the scales cannot be adjusted with a dialog.
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Navigating within the HistoROM diagram
A slide control and two buttons can be found in the bottom part of the HistoROM diagram. You can 
use this slide control to navigate continuously, or use the two buttons to navigate in steps of 
24 hours, within the entire recording period.

Fig. 59: Slide control and buttons in the HistoROM diagram

Selecting events and measured values
You can select an event/a measured value in the diagram with the mouse or keyboard:
• Move the cursor in the diagram to the appropriate point and click with the left mouse button

or

• Use the TAB key or SHIFT and TAB key to move to the next or previous event or measured value.

The text box displays the data of the event/measured value which are also in the table row. Once 
you switch to the “HistoROM Event Table” view, the line in question is highlighted in colour in the 
table.

Fig. 60: Selecting the events and measured values via the keyboard

Slide control

Button

TAB keySHIFT and TAB key
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Selecting special events in the HistoROM diagram
Two events which are dealt with in a special way in the HistoROM editor are logged in the event 
log. If the HistoROM editor detects the event:
• DAT has been attached to other electronics
• Sensor has been changed
the background of the time area occurring before this event is highlighted in colour in the HistoROM 
diagram and the electronics or sensor number is entered in the graphic. If these events took place, 
only the hours of operation are shown for the period before. It is no longer possible to convert 
correctly to the time and date here.

! Note!
If the electronics (or the device) are changed, the operating hours counter can change by a large 
amount. If the HistoROM is switched several times between the devices, various operating hours 
counters can be assigned to the measured values or events. In the graphic display, this results in the 
fact that these differences are also visible in the labelling for the X-axis.

System events
The system events logged in the HistoROM are indicated by a flag above the X-axis. The position 
on the X-axis is derived from the operated hours counter.
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9.14.4 HistoROM event table
The event table displays the events and measured values in tabular form. The display is sorted by 
date (from “latest” to “old”).

Fig. 61: Display screen - HistoROM: events table

Events log display
In the events table, you can use the radio buttons to define how the events are displayed in the table. 
The following display options are available:

• Events:

• Cyclic measured values:

Events Cyclic measured values Events and measured values
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• Events and measured values:

The corresponding table columns are displayed depending on the display method selected:
• ID - running number
• Date - Date and time (of available)
• Hours of operation - In seconds
• Event - Number of the event
• Add. data - Additional information
• Description - Description of the event, e.g. CONFIGURATION MODIFICATION “MEASURING 

MODE”
• Pressure [mbar] - Cyclic measured value for pressure [unit]
• Temperature [degC] - Cyclic measured value for temperature [unit]

The display specified is retained even after you exit the event table.

Selecting events and measured values in the table
If an event is selected in the table, it is highlighted in colour and the text box displays the data 
belonging to the event/measured value which are also in the table row. Once you switch to the 
“HistoROM diagram” view, the cursor is positioned in the diagram on the same event that was also 
selected in the table. The associated data are displayed in the text box.

Fig. 62: Display screen - HistoROM: events log

Text box
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9.14.5 Updating the HistoROM data
Since the measured values are data which are constantly changing, there is no automatic (online) 
update of data from the device in the ToF Tool. However, you can update the data using the 
“HistoROM” menu.

How to update the HistoROM data

1. In the “HistoROM” menu, click “Upload (from device)”.
2. Click “Upload”.

The diagram is redrawn following successful upload from the device.
Scaling then takes place with the device settings then valid from the upload data record.

9.14.6 Printing the data
The HistoROM data are printed with the “Print... (CTRL+P)” function in the “File” menu (see 
Chapter 9.1.9). The “Select Documentation Contents” dialog box was extended for this purpose to 
include the “HistoROM” parameter. The contents of the documentation can be structured 
individually by activating/deactivating parameters in the Print menu of the ToF Tool.
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9.14.7 Saving the events log
The HistoROM gives you the option of saving the log data ("How to save an HistoROM Dataset:" on 
Page 25). In a dialog box, you can select the directory and specify the file name. 
“...\\ToFTool\AppplicationData\” is suggested as the default directory.

The last lines contain the device information:
• Designation/number of the main electronics
• Device serial number
• Order code
• Designation/number of the sensor
• Operating hours counter at start of upload
• System time at start of upload
• Pressure unit
• Temperature unit
• Text (unit) for customised pressure unit (is only displayed if the “USER UNIT” option was selected 

by means of the “UNIT PRESSURE” parameter)
• Conversion factor for a customised pressure unit (is only displayed if the “USER UNIT” option 

was selected by means of the “UNIT PRESSURE” parameter)
• Lower normal operating range limit in Pa
• Upper normal operating range limit in Pa
• Customised limit Pmin process in Pa
• Customised limit Pmax process in Pa
• Lower normal operating range limit, temperature in Kelvin
• Upper normal operating range limit, temperature in Kelvin
• Customised limit Tmin process in Kelvin
• Customised limit Tmax process in Kelvin

! Note!
When you close the ToF Tool or the device, you are asked whether the HistoROM data should be 
saved.

9.14.8 Opening the events log
HistoROM data saved can be opened by means of a dialog box ("How to open a stored HistoROM 
file:" on Page 23).
A distinction is made between two instances when loading a file:
• The file is opened in the context of a device.

If there is a difference between the “Device designation”, “Number of the main electronics” and 
the “Number of the sensor” in the file and the data basis, a message is displayed informing the 
user of this. The process of loading the event data is aborted and the last status is restored.

• The file is not opened in the context of a device.
The HistoROM editor is opened and the data of the HistoROM log are accepted.

! Note!
If the file cannot be loaded due to an error, a message is displayed and the loading process is aborted.
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9.14.9 Documentation of the events log

! Note!
If no HistoROM data have been loaded from the device at the time when the documentation is 
created, the ToF Tool automatically uploads the device data.

The following data are also printed out as information:
• Designation/number of the main electronics
• Device serial number
• Order code
• Designation/number of the sensor
• Operated hours counter at start of upload
• System time at start of upload
• Pressure unit
• Text (unit) for customised pressure unit (is only displayed if the “USER UNIT” option was selected 

by means of the “UNIT PRESSURE” parameter)
• Conversion factor for a customised pressure unit (is only displayed if the “USER UNIT” option 

was selected by means of the “UNIT PRESSURE” parameter)
• Lower normal operating range limit
• Upper normal operating range limit
• Customised limit Pmin process
• Customised limit Pmax process
• Lower normal operating range limit, temperature
• Upper normal operating range limit, temperature
• Customised limit Tmin process
• Customised limit Tmax process
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9.15 "Window" menu

The "Window" menu consists of the following functions:
• Cascade
• Tile
• Arrange Icons

9.15.1 Cascade
This function allows you to cascade several windows.

9.15.2 Tile
This function allows you to display several windows as tiles.

9.15.3 Arrange Icons
This function rearranges the icons.

9.16 "Help" menu

The "Help" menu consists of the following submenus:
• Tof Tool help...
• Envelope Curve Editor Help

9.16.1 Tof Tool help...
Here you can find information on:
• ToF Tool 

(version, copyrights, etc.).
• Endress+Hauser on the Web 

This function takes you to the Endress+Hauser website.
• Online Manuals

9.16.2 Envelope Curve Editor Help
The Envelope Curve Editor Help is not yet available.
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10 Help window

A separate Help window that is opened after calling up the Help function by left-clicking the 
parameter name (in blue).

Fig. 63: Entry window in Parameter and Help Window dialog window

The device parameters are explained in more detail in this window and important input values are 
described.

Help window containing
the associated Operating Instructions
and description of the parameters

Left-click
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11 Navigating ToF Tool

You can navigate ToF Tool using the mouse or key combinations. Some views in ToF Tool have 
special key combinations which only function in this particular view. Some key combinations and 
mouse functions work in all views.

! Note!
The key combinations listed for the Help topics, menus and dialog boxes assume you have a German 
keyboard layout. Note that keyboard layouts for other languages may not be the same as for 
German. If the keyboard language layout differs from the languages installed for ToF Tool, the 
keyboard combinations listed below may not work.

11.1 Navigating the Device List

Key combinations Meaning

� F4 key Switches to the Device List

�,�
UP or
DOWN key

Highlights a device in the Device List

� ENTER key Displays the Parameterisation Editor 
for a highlighted device

��,��
CTRL + LEFT key
or
CTRL + RIGHT key

Switches to next register card in the 
Device List

� RIGHT key Opens a Device Tree in the Device List 
(when highlighted)

�,�
UP or
DOWN key

Highlights a position in the 
Device Tree

� LEFT key Closes a Device Tree

�+	
SHIFT + F10 key Opens the shortcut menu for a 

highlighted Device

�,�,�
UP or DOWN key to toggle between 
the Options in the menu; ENTER key 
to select the required option

Selects an option from the open 
shortcut menu;
toggles between the options in the 
menu

�+�,�+�
SHIFT and UP key
or
SHIFT and DOWN key

Position the ideal echo curve
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11.2 Navigating the Parameterisation Editor

Key combinations Meaning


 F3 key Switches to the Parameterisation 
Editor (when open)

�+�,�+�
ALT + UP key
or
ALT + DOWN key

Toggles between icons on the 
Navigation Bar

�+�,�+�
ALT + RIGHT key
or
ALT and LEFT key

Switches dialog box within a 
Parameter group

�,�+�
TAB key
or
SHIFT + TAB key

Toggles between elements in the dialog 
boxes

�,�+�
TAB key
or
SHIFT + TAB key

Undoes last action in input field

� ENTER key Adopts input in input field and transfer 
to Device

�,�+�
TAB key
or
SHIFT + TAB key

Switches to icons of the Status Bar in 
the dialog boxes


 Spacebar Activates highlighted element of the 
Status Bar in the dialog boxes


 Spacebar Activates or deactivates a highlighted 
check box

�,�
UP key
or
DOWN key

Toggles between options in a 
dropdown list

� F5 key Opens the Scan dialog box

� F1 key Help
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11.3 Key combinations for editing envelope curves

Key combinations Meaning

�+�,�+�
ALT + DOWN key
or
ALT + UP key

Switches to Envelope Curve 
window when Parametrisation Editor 
is open

�+	
SHIFT + F10 key Opens the shortcut menu

�,�
UP, DOWN key, toggles between the 
options in the menu; ENTER key 
Selects the required option

Selects an option from the open 
shortcut menu:

� F1 key Help

��,��
CTRL+RIGHT key or
CTRL+LEFT key

Toggles between cursors

�,�
LEFT key or
RIGHT key

Positions the active cursor

�,�
UP key or
DOWN key

Positions a free cursor on an Envelope 
Curve

��,��
CTRL+UP key or
CTRL+DOWN key

Changes the assignment of a cursor to 
the Envelope Curve

�,�+�
TAB key or
SHIFT+TAB key

Switches to the next group in the 
Envelope Curve window

�,�
DOWN key or
UP key

Toggles between options of the 
Envelope Curve List


 Spacebar Activates or deactivates a highlighted 
Envelope Curve


 Spacebar Executes an action assigned to a 
selected button  

�+�
CTRL+P Print
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11.4 Navigating toolbars using the keys

Key combinations Meaning

	 F10 key Activates the menu bar

�,�+�,
�,�

TAB or
SHIFT+TAB or
RIGHT key or
LEFT key
(when toolbar is active)

Activates the next or previous button 
or the next or previous menu in a 
toolbar 

� ENTER key (for an active menu on a 
toolbar)

Opens a menu

� ENTER key (when a button is active) Executes an action assigned to a 
selected button 

�+

ALT + SPACEBAR Opens the icon menu

�+�,�+�,
�+�, ...

ALT + LETTER key Opens a menu on a toolbar using the 
underscored letter in a menu name 
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Error description Cause Action

Access to serial interface Serial interface busy. If a program which 
accesses the serial interface is installed 
(but is not currently active), ToF Tool 
cannot communicate (without the 
appropriate error mes sage).

In the "Options" menu, select the 
"Settings" option.
Check to see if the serial interface is 
already being used by another device 
(mouse, Commuwin II etc.).

Opening pdf files If the "Open" option is selected in the 
"File" menu, pdf files cannot be opened.

Select the "View documentation" 
option in the "File" menu. Acrobat 
Reader starts automatically.

The envelope curve is shifted 
to the left for bypass 
measurements. The highlight 
is still at the right point.

The microfactor was also applied to the Z 
distance.

Refer to the highlighting for the 
measurement distance.

JPG is not displayed. The graphics are not shown because they 
are permanently assigned to another 
application.

Install Internet Explorer (Version 5.x or 
higher).

During cyclic envelope curve 
creation, a system crash (e.g. 
due to power failure) leads to 
data loss.

The envelope curve file could not be 
saved properly.

Envelope curves can be renamed from 
TMP files to CRV files and then 
accessed.

ToF devices which do not 
exist are in the device list.

If a ToF device is taken from the bus and 
rescanned, the device stays in the device 
list and the icon is crossed through.

Select the "New Device List..." option 
in the "File" menu and res can the bus.

The operating system says it 
has insufficient memory. 

Swap file (virtual memory) is not big 
enough.

Increase swap file.

During cyclic envelope curve 
creation the storing procedure 
takes a very long time.

Storing a large number of envelope 
curves (> 1000) may demand long time 
(> 10 min).

Increase main memory or await storing 
procedure.

Several hundreds of over 
lapping envelope curves have 
been plotted.

After switching to a new configura tion 
group it takes a while before the new 
group is displayed.

Unselect "Overlapped Curve" in the 
Envelope menu before switch ing to the 
new configuration group.

The ToF-Tool has been 
quitted and can not be started 
again.

Occasionally, proper termination of the 
processes (ToF*.exe and PB_DPV*.exe) 
may fail. If so, the ToF-Tool can not be 
started again.

Close the processes via the Task 
Manager or reboot the computer. 
Afterwards the ToF tool can be started 
again.

A bus scan has been per 
formed and the saved device 
list is to be restored.

Not all devices, that have been present on 
the bus, are displayed.

Devices are only displayed, if the 
respective device description is 
available.

The ToF-Tool does not set up 
a connection with the 
Proficard 

A Proficard driver of less than V 5.22 is 
installed

Install the current driver (contained on 
the CD in the "Drivers" direc tory)

The display of the first echo 
band does not begin at the 
peak of the highest echo

The peak value of the highest echo was 
not saved with the envelope curve

This function is only implemented with 
the display of the current echo

Download to the device failed The communication interfaces used for 
the uploads and downloads are not 
identical

Use the same communication interface 
(poss. make remark in file name)

After an update of the ToF-
Tool, no instrument 
descriptions are available

The installation process was inter rupted 
after the restart

Complete the installation process after 
restart by adding the device 
descriptions

The upload file cannot be 
viewed offline

No offline functionality implemented Create documentation when the device 
is online
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The envelope curve is not 
displayed, although the 
respective checkbox has been 
marked.

Via the Curve menu it is only possi ble to 
display but not to read in the curves.

The curves must be read in via the 
Envelope menu or via the recorder 
symbols.

General communication 
problems concerning sev eral 
instruments.

Registry entries cause incorrect 
information.

Please deactivate the FIFO-buffer in 
systemcontrol/system/devicemanager

Installation on Win 2000 or 
Win XP is terminated after a 
few percent.

Access rights are not sufficient. Ensure sufficient administrator access 
rights (see Installation Instructions)

Start of the parameter edi tor 
of the ToF Tool fails under 
Win XP

Missing write permission in the “program 
files” directory.

Ensure that sufficient rights are 
established by the administrator (see 
Installation Instructions).
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